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Reduce IT  
infrastructure costs  
with the right PDF solution.
Standardize on the PDF software that meets the need  
of the users and keeps the corporate costs down.

 

Organizations of all sizes attempt to find the best way 
to deploy technology and tools that will drive user 
productivity while still keeping total infrastructure costs 
in check. This whitepaper will take a closer look at PDF 
technology and describe how the right PDF tools can 
help organizations empower employees while reducing 
overall IT costs.
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Executive summary
Corporate IT organizations constantly wrestle to 
balance the delivery of IT infrastructure and 
services that add value to the enterprise, while 
keeping infrastructure costs in check. For example, 
workstation management is a large portion of any 
corporate IT budget, and opportunities exist to 
reduce infrastructure costs while delivering high 
user value.

Within the scope of desktop services, IT provides 
productivity tools to their users. One such tool, 
PDF software, significantly reduces the need for 
printing to paper and filing paper documentation, 
facilitates workflow processes, and enables 
content to be read, edited, and converted on 
almost any device or platform. As functional 
groups and users adopted various PDF solutions 
to electronically exchange and store documents 
identical to their printed states, PDF technology 
permeated throughout most enterprises. However, 
most organizations didn’t standardize on one  
PDF solution, presenting the opportunity for 
organizations to adopt one business-ready PDF 
solution to lower IT infrastructure costs and 
increase user productivity by using Nuance Power 
PDF solutions.
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The challenge: controlling rising IT  
infrastructure costs
It is no secret that IT leaders and managers are under constant pressure 
to deliver increased productivity and value to end users and business units 
while simultaneously keeping IT infrastructure costs in line. Total Cost of 
Ownership (TCO), which reflects both direct and indirect costs associated 
with IT hardware, software, operational, and support services, has been a 
management benchmark for many years. Within the scope of TCO comes 
workstation management, which encompasses a large portion of IT budgets. 

Workstation management can represent up to 45% of the IT budget1. It is well 
documented that the cost of workstation management can far exceed the 
initial purchase price of a desktop or laptop computer. According to Gartner, 
an organization that employs 2500 users will spend an average of $5,000 
per year, per computer deployed2. When considering an average desktop 
computer costs around $1,000 to purchase and is used for three years, the 
management costs can be significant in comparison. As a result, workstation 
management is a prime candidate for cost savings and user productivity 
improvements. It is also important to note that workstation management 
costs grow exponentially as technology cycles drive IT departments to 
integrate newer technologies with legacy counterparts. 

The more workstation assets age and new technology becomes more 
powerful, the more challenging it is for organizations to maintain productivity. 
Extra time spent learning non-intuitive user interfaces, and employees 
taking time from their jobs to help others, reduce effectiveness of everyone. 
Meanwhile, there is also a strain on the IT support organization as IT staffs 
have to support a variety of sometimes difficult-to-use tools and applications, 
maintain multiple versions, and periodically patch them to maintain effective 
security. These issues affect the entire organization and increase TCO.

Within the ecosystem of desktop/laptop productivity tools, Portable 
Document Format (PDF) is the established industry standard for presenting 
documents for electronic exchange and archival independent of software, 
hardware, and operating environments. PDF plays a vital role across the 
organization, from preserving legal content, facilitating the exchange for 
marketing content for the sales organization and potential customers, using 
PDF forms to efficiently capture customer or internal corporate data, as well 
as serving as a workflow medium throughout the organization. 

Since PDF technology has become beneficial across the entire organization, 
choosing the right PDF tool provides IT organizations an opportunity to  
control costs and positively impact productivity across the whole organiza-
tion. In short, a PDF solution must be cost-effective while delivering benefits 
to those who need various levels of functionality.

However, the PDF market is complicated. Different tools offer different 
levels of functionality for different prices. It is common for organizations to 
juggle multiple solutions from different vendors which offer different levels 
of functionality (readers, PDF creators, converters, etc). In general, these 
solutions span the cost spectrum, from free PDF readers to very expensive, 
feature-packed PDF creation tools. Even free solutions aren’t quite free.  
Often these solutions come in the form of limited performance (based on 
outdated PDF standards), infrequent security patching, and expensive or 
insufficient support. In many cases, these “free” PDF readers (i.e., Adobe 
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Reader) have security vulnerabilities that expose users and corporate 
networks to malicious attacks, forcing the vendor to frequently patch the 
software. This generates extra IT efforts to deploy these updates across 
the organization, resulting in added IT cost and time. Based on Nuance’s 
research, enterprise deployment of such updates can cost as much as $3 
USD per workstation per year, which can add up over time for large organi-
zations with several thousands of users. On the other hand, the expensive 
solutions are often inflexible and limited in choice; charging a higher price for 
full functionality, when only a smaller set of functionality is required.

Many organizations are committed to a high quality content management 
and archival program for their content. When companies don’t commit to a 
standard PDF solution, compatibility issues may arise down the road when 
the archived content is requested and cannot be opened. This can be the 
case specifically when creating interactive PDF files which contain non- 
text elements, such as video. Different PDF tools often integrate content 
differently, leading to compatibility issues when attempting to open and 
view them. When considering these issues, businesses should seek a PDF 
solution that intelligently fits into their existing IT infrastructure without 
creating a cost burden or impacting users’ productivity.

What do users need to do to keep  
infrastructure costs low while choosing  
a PDF solution? 
In order to gain control of infrastructure costs, users need consistency, 
standardization, and efficiency at every turn. This applies to any workstation 
experience, whether it is interacting with their screen, running their main 
business applications, or using productivity tools. PDF tools are no exception.

To cost-effectively deploy and use PDF technology within an organization, 
users must be able to:

–– Deploy standardized software for working with PDF files

–– Eliminate redundant software (multiple applications that serve the same 
purpose)

–– Implement a solution that meets their immediate needs while avoiding 
costly unused features

–– Scale their PDF solution over time, meeting changing demands and 
business practices

IT organizations can also impact the bottom line with cost-efficiency gains 
when selecting and deploying a PDF solution by:

–– Customizing installations to suit a variety of workstations

–– Deploying a solution that performs well across various types of 
workstations with varied system specifications, including some older  
and the newest operating systems

–– Optimizing PDF file sizes to reduce the need for extensive storage space

–– Employing a solution that works well with the existing software and 
hardware infrastructure
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Nuance Power PDF
Nuance® Power PDF is a complete solution to create, convert, edit, and 
securely share PDF files. It is designed for cost-effective deployment in a 
corporate setting. The solution is flexible enough to adapt to an existing 
infrastructure, integrate with a wide range of corporate IT services, and is 
available with a licensing policy that ensures good value, enabling  
businesses to improve efficiencies and productivity using the PDF  
format without increasing their infrastructure costs.

Nuance Power PDF delivers an intuitive PDF solution that is easy to learn, 
making users productive more quickly. Users can quickly transition between 
document authoring and PDF publishing. Power PDF was built from the 
ground up with the needs of business users, knowledge workers, and  
professionals in mind. As a result, the features, capabilities, and user inter-
face are all optimized to support the most common PDF workflows, with  
as few clicks as possible. 

The Nuance Power PDF solution helps users and organizations work faster, 
improve productivity, and do things with PDF solutions that they simply did 
not know were possible. Power PDF supports effortless creation of 100% 
industry-standard PDF files and the most accurate conversion of PDF files to 
Microsoft® Word, Excel®, PowerPoint and Corel® WordPerfect® documents. 
The application also provides unique features such as word-processing-like 
editing, workflow controls for processing hundreds of files at a time, cloud 
connectivity, PDF security, and Dragon® Notes speech recognition to  
dramatically increase business productivity.

Power PDF can also provide industry-specific benefits and help specific 
departments perform their work better.

–– Financial services companies use Power PDF to ensure the security 
and integrity of sensitive financial records with permissions, “Save As” 
integrations with document management systems, and powerful form 
creation and management capabilities.

–– Healthcare facilities use Power PDF to review and archive patient records 
securely with dynamic collaboration tools and the ability to search and 
redact PHI/PII, create PDF/A files, and encrypt and flatten documents 
before storing or sharing.

–– Law firms and legal professionals use Power PDF to support e-Discovery 
and e-Filing workflows to search across multiple files and folders, convert 
to searchable PDF or PDF/A, or perform Bates numbering, redaction, and 
inspection (metadata scrubbing), and more.

–– Accounts payable and other departments use Power PDF to automate 
repetitive tasks associated with invoice and order processing with batch 
sequences to extract/insert pages and add comments, watermarks, 
redactions, dynamic stamps, and more.

Nuance Power PDF delivers a superior alternative enterprise-level PDF 
solution to Adobe Acrobat which is more cost-effective and feature-rich.
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Cost and productivity benefits for both users and IT alike
PDF solutions can be segmented into three broad categories: simple readers, 
entry-level products with limited functionality, and high-end solutions with 
the most advanced features used by just a few power users. For businesses 
that are trying to control infrastructure costs, this makes it hard to deliver 
a standard PDF solution that balances cost with functionality. Some users 
require more than a simple reader, but not every user requires the most 
advanced functionality. Nuance Power PDF presents an alternative that can 
be implemented across an entire organization. It’s easy enough for novice 
users to perform basic tasks, with the advantage of offering more sophisti-
cated features that businesses regularly use.

Nuance Power PDF offers an easy-to-learn interface which enables both 
basic and power users alike to enjoy the benefits of document capture, 
editing, conversion, and storage. Power PDF can not only read incoming 
“native” digital PDF documents, but it can also support workflow processes 
where printed documents can be scanned and captured as PDF files using 
networked copiers, and subsequently routed to centralized locations for 
subsequent action (i.e., editing or conversion) or long-term storage. Power 
PDF also supports cloud services, which enables global collaboration,  
further increasing organizational efficiency.

While many basic PDF solutions offer functionality such as reading and 
annotating, they do not address enterprise needs that make it simpler for the 
IT organization to install, maintain, and support as well as capabilities needed 
to meet corporate compliance and governance requirements. Power PDF 
delivers key enterprise needs that span beyond user functionality:

–– Customization kit: To support large enterprises, Power PDF comes with 
an installer customization kit that makes it easy to maintain enterprise-level 
governance and control.

–– Read-only mode settings in the customization kit help organizations 
enforce compliance with segregation of duties and least privilege 
governance principles required by GAAP, SOX, GLBA, HIPAA, e-Discovery, 
and other internal control best practices and regulatory mandates.

–– PDF/A compliance: Power PDF simplifies the way organizations meet 
PDF/A compliance requirements. Users are notified if a PDF/A file does 
not meet compliance requirement, so they can fix them on the fly—further 
saving time and making sure the files are in full compliance.

–– Predefined PDF creation profiles: The ability to set up and maintain PDF 
creation profiles allows IT departments to reuse settings and share them 
with others. This translates to the ability to standardize the generation of 
PDFs across the organization.

–– World-class customer support: The Nuance Power PDF maintenance 
and support plan provides access to a human-powered helpdesk and PDF 
software updates as they become available.  
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A consolidated, manageable PDF solution 
Using a PDF solution that enables users to perform different functions with  
a PDF file, such as reading, creating, editing, sharing, and converting PDF 
files within a single application is much more efficient than using point  
solutions for each function. From an IT perspective: when IT departments 
approve and deploy a standard toolset across an organization, it is well 
documented that cost benefits are achieved. In some cases, this can be up  
to 25%3. This approach reduces the number of applications an organization 
has to actively deploy, manage, and support. The organizational learning 
curve is also much faster, which decreases time spent learning multiple 
toolsets which perform the same function, as well as lower IT support  
costs associated with supporting redundant toolsets.

Users only have to learn one interface and don’t have to switch back and 
forth between tools. Additionally, using a single solution reduces the need for 
redundant PDF tools which add expense to install, maintain, and support; not 
to mention complicating the goal to maintain a standard PDF format across 
business units and the organization as a whole. Often different PDF solutions 
support different levels of document control, which also makes compliance 
and governance challenging.

Many PDF solutions are licensed in a manner that makes them expensive and 
prohibitive to deploy. Often a few users only need the advanced functionality, 
and these PDF solutions offer limited flexibility when it comes to how these 
features are licensed. This leads to onerous, inefficient licensing models 
(along with the associated support costs), which force organizations to pay 
for functionality they don’t often use.

Nuance Power PDF offers a simple licensing program which delivers more 
value than complex seat-counting and point-collecting licensing programs 
used by other vendors. As new Power PDF licenses are added, the existing 
ones are taken into account to potentially leverage a higher volume band that 
offers more discounts. IT organizations can enjoy predictable Power PDF 
software licensing costs through the Volume Licensing Program. In addition, 
Nuance also offers support and maintenance services at easy-to-calculate, 
reasonable price points, which not only saves money, but helps users stay 
current with their software and access updates and upgrades. In addition, 
users and IT organizations get access to qualified Nuance support personnel. 
This enables IT organizations to have a predictable, manageable program to 
support their organization’s PDF needs.

Seamlessly integrate PDF with other enterprise software services
Many organizations use Document Management Systems (DMS), such as 
HP WorkSite, OpenText’s eDOCS and Enterprise Connect solutions, and 
Microsoft SharePoint to cost-effectively store and organize their digital 
assets as well as save money on paper and storage costs. In addition, many 
companies rely on cloud services such as Dropbox, Box, Google Drive, and 
Evernote for off-premise storage to promote global collaboration. Nuance 
Power PDF seamlessly integrates with these DMS and cloud-sharing services 
allowing users to easily access PDF documents stored in the DMS systems 
or in the cloud from inside Power PDF, edit them, and save them back to the 
storage location. 
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Easy integration with document workflow processes
Organizations continually seek ways to reduce costs and increase produc-
tivity. One way of doing is to go paperless by creating electronic workflows 
that automatically route documents from one workgroup to another to gain 
efficiencies in areas such as customer service and better collaboration 
between engineering and manufacturing. 

Using PDF technology to facilitate the creation, editing, conversion, and 
centralized storage of information helps companies and organizations save 
money and become more efficient. Utilizing electronic workflows also signifi-
cantly reduces manual errors introduced when marking up paper documents 
and potentially losing these edited documents along the way. Nuance Power 
PDF can greatly assist in this area as an easy-to-use solution to facilitate 
better workflows within an organization. 

For example, when a business process requires paper forms to be  
processed, modified as necessary, and digitally saved, Power PDF reads 
the form from the scanner and converts it into a PDF form using automatic 
form field detection. Users then make any edits to the form fields and text 
using Power PDF. The PDF editing capabilities within Power PDF save users 
time and streamline business processes. Additionally, if required, Power PDF 
can save documents in PDF/A format for long-term archival storage while 
maintaining document integrity.

Enterprise PDF for every business user
PDF technology has become so ubiquitous that almost any functional group 
within an organization or institution has found benefit in using it. Global 
organizations, as well as those with many remote users, need PDF tools that 
not only integrate with enterprise-level applications, but are easily managed 
and supported at a global level. When users and departments use multiple 
PDF solutions, it increases support and management costs. Multiple brands 
of software that perform the same function mean more for IT support staff to 
learn and support, as well as added complexity to business processes when 
employees are using different tools.

In addition, IT organizations benefit when standardized tools are easy to 
install and customize for each user. Using standard software distribution 
mechanisms, IT workstation management teams can easily create custom 
installation kits with Nuance Power PDF. These kits enable each user or user 
group to get the appropriate level of functionality required, as well as provide 
enterprise-wide governance and control. 

Another enterprise-level functionality of Power PDF is predefined PDF-
creation profiles. With it, IT personnel create user profiles, making it easier 
and more efficient to deploy function-dependent configurations across the 
organization.

Efficiency through automation
In many situations, users spend a significant part of their workday creating, 
converting, editing, and storing PDF files. Repetitive tasks such as choosing 
the files and folders to work with, setting document attributes (e.g., security, 
adding watermarks, and corporate logos) and searching for processed PDF 
files can be time-consuming and inefficient. 

Nuance Power PDF automates many of these tasks—improving user 
productivity and reducing inefficiencies. One way Power PDF improves user 
productivity is through one-step PDF creation of Microsoft Office documents, 
Lotus Notes, and Microsoft Outlook emails, as well as web pages. 
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Power PDF also features the use of “watched folders” to automate PDF 
creation tasks from a wide range of formats. This capability simplifies the 
process of converting scanned pages or documents of different file types into 
PDF format through automation. Power PDF can be configured to monitor a 
designated folder (most often a network folder) for incoming files or scanned 
pages. Once an incoming file is sensed, it is automatically processed (based 
on user defined settings) and the output file is put in a user-defined folder. A 
use case example is where a legal department has business process where 
all newly executed printed contracts are scanned into a network folder on a 
daily basis. Power PDF picks them up, converts them to text-searchable PDF, 
adds a stamp, and sends them to a destination folder. 

Optimize PDF file sizes to reduce storage requirements 
Processing complex PDF files, such as those with pictures and graphics, 
can result in very large file sizes. Couple this with the fact that more and 
more information is created by different users across the organization, and 
it is no wonder there is a potential strain on storage requirements. Nuance 
Power PDF can optimize PDF file sizes by removing unnecessary or hidden 
elements and compressing images; helping to dramatically reduce storage 
requirements – whether it is on-premise or in the cloud – which in turn can 
reduce storage costs.

Extract more value from high-volume scanners and multi-function printers
Many organizations have desktop and network scanners and multi-function 
printers that help users copy and scan printed documents. In most cases 
(unless an OCR product is used), scanned documents are image-based 
and text cannot be edited or searchable. Nuance Power PDF natively 
communicates with scanners to scan printed documents and convert them 
to a text-searchable PDF format, adding significant value for companies that 
need to meet government compliance requirements. Text-searchable PDF 
documents offer tremendous value for audits compliance or e-Discovery.

Additionally, leveraging the Scan Inbox functionality, Power PDF monitors a 
local or network folder and notifies users when documents are placed into 
the designated folder and ready for further action by the user. Using Nuance 
Power PDF, in conjunction with high-volume scanners and copiers to perform 
this task, reduces printing and paper storage costs, as well as provides a 
means to quickly create large amounts of text-searchable documents for 
archiving and digital storage. 

Use Power PDF with both older hardware and Windows 10
Most organizations have a mix of desktop and laptop technologies that is 
based on their refresh cycles. Personal computing technologies constantly 
evolve and many companies struggle to keep up. One of the easiest ways to 
reduce infrastructure costs is to find ways to leverage older hardware without 
costly upgrades. Nuance Power PDF has a small application footprint, so it 
doesn’t add upgrade costs to legacy workstations just to add important  
PDF capabilities.

While Power PDF can easily be installed on older desktop and laptops, it 
also supports the latest Windows platforms. For example, many companies 
are making the transition to Microsoft Windows 10 for their workstation 
environment. As companies contemplate this migration, IT support personnel 
must ensure they address total software needs and users have the best tools 
for their environment. Power PDF is fully compatible with Windows 10 and 
functions perfectly in this environment. Nuance works closely with Microsoft 
and other partners to enable users to take advantage of the latest technology 
in the smoothest manner possible.
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Conclusion 
PDF technology is used across the enterprise, yet inefficient deployment of 
this important technology adds cost and aggravation to both users and IT 
alike. The PDF options available to businesses are vast and can be mislead-
ing. For example, free products turn out not to be free when other costs are 
factored in. Other solutions can be inflexible both in their licensing model as 
well as the fact that companies must pay for much more than most users 
need. 

What is required is a flexible PDF solution that offers options when it comes 
to feature deployment, integration with existing software services (such as 
DMS, cloud services, and companion productivity tools such as Microsoft 
Office), as well as an intuitive, simple to use interface. IT leaders and manag-
ers can find opportunities to reduce IT infrastructure costs and increase the 
productivity of their users through adoption of Nuance Power PDF. 

Checklist for assessing infrastructure costs of 
PDF technology 
Consider the following ten questions in the context of your existing 
infrastructure:

1. �Is your PDF solution a single, all-encompassing platform that can handle 
creation, conversion, and editing?

2. �Does your solution’s licensing model allow you to deploy the same solution 
across your entire infrastructure?

3. �Can you customize individual installations, increasing your mileage from 
the same software by creating user-unique feature sets?

4. �Does your PDF solution offer advanced features you will not regularly use? 
If so, what is the impact of these features on your implementation and 
maintenance process?

5. �Beyond the software cost (which may be free), how much will you be 
expected to pay for support, maintenance, and critical security updates?

6. �Does your PDF solution integrate with other applications and services of 
your network, including Document Management Systems (DMS) and cloud 
services?

7. �Can your PDF solution support workflow automation? How could this be 
used to streamline processes and save money?

8. �How difficult, time-consuming, and costly would it be to scale your number 
of installations over time? Can your solution support your ongoing growth?

9. �Which individual applications would be made redundant by the intro-
duction of your new PDF solution? How much can you save by removing 
unwanted licenses?

10. �How will your chosen PDF solution perform across the spectrum of 
hardware you run, including legacy hardware?
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Practical application 
Create a custom installation package for distributed deployment

The multi-user version of Power PDF Advanced includes a versatile tool, 
the Nuance Customization Kit, that helps system administrators create a 
personalized install package of Power PDF Advanced for company-wide 
deployment. This enables them to deploy the application based on the  
organizations’s internal rules and best practices. After the customized  
installation package is created by the Customization Kit, IT professionals 
can use various client installation methods, such as command line, Active 
Directory, SCCM,or SMS, to deploy Power PDF Advanced to individual users.   

Using the Customization Kit, system administrators can choose where  
Power PDF Advanced will be installed on a user’s PC, pre-define the serial 
number and make it read only, set feature installation states, set visibility of 
features on the Custom Setup dialog, configure default application settings, 
deploy custom files, add hotfixes to the installation, and import pre-defined 
application settings.

Customization of the installer can be done in the following steps:

1. Launch the Customization Kit. 

2. Click “Open Package” in the Home ribbon and select a supplied .msi file.

3. Specify parameters for your installer package in the different panels.

4. Optionally add hotfixes, additional files, or import application settings. 

5. �Click “Publish Package” in the Home ribbon to finalize the customized 
installer for your own deployment.

6. �Distribute this customized installer to end users, or use it for a command 
line, or other type of installation method. 

Working with the Customization Kit

1. �Launch the Customization Kit located in the Tools folder of the pre-installed 
Power PDF Advanced file set (...\Tools\CustomKit\CustomizationKit.exe).

2. �Choose “Open Package” on the Home tab, then browse to an .msi 
file (Nuance Power PDF Advanced.msi) available in the System32 and 
System64 folders of the pre-installed files set and open it. Select either the 
32-bit or 64-bit package.
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The first group of options includes Personalization, General, Microsoft 
Office Integration, Other Integration, Connectors, Document Processing, 
Languages, Signature, and Application Options. Customizations from this 
group are saved into a transform (.mst) file, which needs to be used during 
the deployment.

1. Click “Personalization.”

2. �This panel lets you specify basic customer information (such as User 
Name, etc.) and the serial number.

3. �Optionally mark the “Suppress display of Serial Number” checkbox to hide 
this screen from your installation flow.

4. �You can choose the default installation value or browse to select a different 
location for the installed application files. 

5. �You can prevent end-users from modifying each one of the above options. 
Select all/none or any one of them and mark the ones you want to lock.
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The next group of options lets you set a variety of generic parameters.

1. Click “General.”

2. �This panel lets you specify general settings for working with PDF files, 
related programs and applications (Power PDF Advanced, Convert and 
Create Assistant). Mark the desired settings. 

3. �You can choose the setup type that best suits your needs. Mark the first 
option if you want to display only a few basic dialogs or use the radio 
buttons below to choose Typical or Custom installation.

4. �You can define how the application’s Help system will be available for the 
users. Click the radio button for online Help from Nuance, or select the  

“On premises” option. Choose the “On premises” option if the users’ 
workstations have no live Internet connection to the Nuance website.  
The Help files are available separately as well, and can be posted on a 
local server. 

Below this group, you can set Microsoft Office integration parameters.
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1. �Click “Microsoft Office Integration.”

2. �Select the Microsoft Office applications in which you want Power PDF 
features, including PDF conversion and creation capabilities. In Microsoft 
Outlook, the offering also includes e-mail archiving to PDF.

3. �Enable the Nuance PDF toolbar in Microsoft Office: Turn this setting on to 
show the Nuance PDF toolbar in Office applications.

4. �Enable logging in Microsoft Office applications: Turning this setting on 
helps application troubleshooting without causing performance issues.

The Other Integrations group offers similar options for other supported 
applications.

1. Click “Other Integrations.”

2. �Select the needed Power PDF integrations for the supported programs and 
browsers. Select the Windows Desktop Search integration if you want to 
enable Windows Desktop Search to index and search PDF files.   
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The Connectors group lets you include cloud and Document Management 
Systems (DMS) integration in your customized install package.

1. Click “Connectors.” The list of available connectors is displayed.

2. Mark “Enable Connectors” so that you can make your selections in the list. 

3. Enable or disable a connector by marking the checkboxes one by one.

Setting Document Processing parameters lets you define what features to 
install or remove from the installer from the listed feature sets.

1. Click “Document Processing.”

2. �Choose “Reader mode” to create a package with a pre-defined set of 
functionality. If Reader mode is selected, the application will be installed 
without the features that enable editing the core content of PDF files. (PDF 
conversion, creation, annotation, and security features remain available.) 

3. �When “Reader mode” is off, you can select the desired functionalities one  
by one. 
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The Languages group lets you select which user interface and text-to-speech 
languages to install for Power PDF.

1. Click “Languages > User Interface.”

	 a. �Make your choice of user interface languages: Installation language only, 
all available languages or the selected languages.

2. Click “Languages > Voice.”

	 a. �This is enabled by default but you can turn it off. Disable this if installa-
tion package size is a concern, or text-to-speech voices are not required. 

	 b. �If you choose to include this in your installation, choose between having 
the installation language only, all available languages, or the selected 
languages. 

Next are the Signature options.

1. Click “Signature.”

2. �Use these options to set default states for digital signature preferences and 
prevent them from changing. These settings have effect on what informa-
tion is required or can be displayed in the signature when digitally signing 
a document using Power PDF. For example, you can enforce that a signing 
reason or a time stamp be added to the signature. 
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The Application Options panel lets you choose which of the listed options 
could be changed by the user, and shows other commands that you can 
enable or disable in the File menu or the Edit ribbon.  

1. Click “Application Options.”

2. Make your choice.

Now that you have set all desired parameters, you can optionally create a 
transform file (.mst) for your installer. To do this:

1. Go to the “Transform” tab.

2. �Click “Generate Transform.” This option gives you the opportunity to create 
a transform file (.mst) based on the differences between the open package 
and the modifications set by yourself.  

3. Choose a save location, specify a file name, and save your transform file.

Finalizing the transform file at this stage is optional; you can also include 
other items in your installation package. The following steps let you add 
hotfixes and other files. These, too, will become parts of your installation 
package but are included outside the transform file.

1. Click “Add hotfixes to Installation.”

2. �Use the two lists to add/modify/remove and reorder executables that you 
want to be launched before and after installation. 
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In addition, you can also add other files (for instance for replacing program 
files with newer versions) to your customized package.

1. Click “Additional Files.”

2. You can add/modify/remove and reorder files for your package.

To distribute Power PDF Advanced with standardized settings across 
your company, you can extract settings from an already installed and 
configured Power PDF Advanced and include these in your deployment 
package. If you want to import settings from a copy of Power PDF Advanced 
that you installed and customized on another PC, you need to install the 
Customization Kit on that machine, too, and using its Collect Application 
Settings Wizard, gather the required settings and save them to a shared 
location. Once completed, you can import those settings to the package you 
customize on the primary machine. 

1. Select Import “Applications Settings.”

2. Select an “Import Mode.”

3. �If you selected “Use settings from the locally installed product,” choose 
the settings that you want to import from the list under “Settings to Import.”

4. �If you want to import settings that you collected on another machine, then 
select “Browse for shared product settings” and locate the folder where 
the collected settings are stored. 

5. �Optionally, you can enable or disable end-users to modify PDF creation 
settings after installation.  
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Once you are finished preparing the desired parameters, you are ready to 
publish your package. 

1. Go to the “Home” tab.

2. Click “Publish Package.”

3. �Set a target location. It is recommended to have an empty folder for your 
published package.

4. Select which versions to publish: 32-bit and/or 64-bit. 

Once the package is ready, you can share it with the users to install on  
their own, use command line install, or network deployment methods for 
company-wide deployment. 

For more information on network installation, click here to download the 
Network Installation Guide. 

White PaperDocument Imaging Solutions
Nuance® Power PDF20

Copyright © 2016 Nuance Communications, Inc. All rights reserved. Nuance, and the Nuance logo, are trademarks and/or 
registered trademarks, of Nuance Communications, Inc. or its affiliates in the United States and/or other countries. All other 
brand and product names are trademarks or registered trademarks of their respective companies. 

NDI-148 FEB 2016

About Nuance Communications, Inc.
Nuance Communications, Inc. is a leading provider of voice and language solutions for businesses and consumers 
around the world. Its technologies, applications and services make the user experience more compelling by transforming 
the way people interact with devices and systems. Every day, millions of users and thousands of businesses experience 
Nuance’s proven applications. For more information, please visit: www.nuance.com.

http://content.nuance.com/PowerPDF/Power_PDF_Advanced_Network_Installation_Guide.pdf
http://www.nuance.com

